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1.2 Introduction

Introduction

Welcome to Quarterback Tools Deluxe - a package of disk and file management
tools that can help you recover from disk problems, speed up your disk
access, and manage your files and disks better.

Please read this manual in its entirety. While you cannot physically damage
your disks with the programs in Quarterback Tools Deluxe, you may put the
contents of your disks at risk by not understanding the operation of these
programs.

Quarterback Tools Deluxe consists of the following programs:

* Quarterback Tools 2.0 - A program to help you find and correct disk
errors, recover files that have been accidentally deleted, and optimize
your disk access. In addition, for advanced users, Quarterback Tools
includes a disk editor, which lets you directly examine and modify the
information contained on your disks. Quarterback Tools also includes a
macro capability, a complete AREXX port for advanced users, and is
completely customizable to your way of working.

* Replicator - A program to quickly and easily duplicate a large number of
floppy disks. You can duplicate to multiple floppy drives at the same
time, and even save an entire disk image as a file on your hard disk to
use later.

* Locator - A program that helps you quickly locate files on your disks.
You simply provide any part of a file name, and Locator will search the
entire disk (or just a sub-drawer of the disk) and find all files that
match that name. For each file found, Locator can tell you the location
of the file, information about the file, and show you a portion of the
file’s contents.

* Encryptor - A program to encrypt and decrypt files. You can use this
program to keep others from seeing the contents of your files; only those
people who have the file’s password will be able to decrypt and use the
file.

* File Eraser - A program that irretrievably erases a file’s contents, and
then deletes the file. File Eraser includes an option to erase a file



qbthelp 3 / 52

using the US Department of Defense approved method for permanently
erasing files. You can use this program to permanently remove sensitive
information from your disk; no file recovery program, not even
Quarterback Tools, will be able to recover the file’s contents.

* Disk Eraser - A program that irretrievably erases either the unused
portions of a disk, or the entire disk itself. Like File Eraser, Disk
Eraser includes an option to erase a file using the US Department of
Defense approved method for permanently erasing files. You can use this
program to permanently erase files which you have already deleted, or to
permanently erase all files from a disk.

* Keystroke Finder - A program that shows you the appropriate keystroke
combination to type any character on your Amiga. For example, Keystroke
Finder can show you how to type accented characters like ä and ç, and
special characters like ©. Keystroke Finder works with any keyboard and
"keymap" setting.

* System Mover - A program that simplifies moving system files - such as
fonts, printer drivers, and system libraries - from one disk to another.
System Mover can show you the version number and information about the
files it’s moving so you can be sure you are using the latest versions
of your system software. Also, when moving fonts, System Mover
automatically updates all of the appropriate font information files, and
even automatically moves "metric" files, which are necessary for programs
that use PostScript printers.

* Brain Cloud - A program that renders a floppy disk temporarily unusable
by the system, without affecting any of the disk’s contents. A disk that
has a "brain cloud" cannot even be formatted by the Amiga!

Using the Programs

Each of the programs in Quarterback Tools Deluxe is described in more
detail in the following chapters. All of the programs can be run from
either the Workbench, by double-clicking on their icons, or from the CLI.

There are also several keyboard shortcuts available when using these
programs. The shortcuts that apply only to a particular program are
described in the appropriate chapter. Shortcuts that apply to all programs
in the Quarterback Tools Deluxe package are covered in the final chapter,
Shortcuts.

All of the programs in Quarterback Tools Deluxe except Keystroke Finder
will operate with AmigaDOS 1.2 and 1.3. However, they are designed to work
best with AmigaDOS 2.0 or later, and Keystroke Finder requires
AmigaDOS 2.0 or later for its operation. If you are using AmigaDOS 2.0 or
later, the window displays in these programs will look best if you use a
high-resolution interlaced Workbench screen (called "high res laced" in the
ScreenMode preferences editor), and use Topaz-11 as your Workbench screen
font.

Program Options

Many of the Quarterback Tools Deluxe programs have optional parameters that
you can specify when you start the program. These parameters are described
at the end of each chapter.
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To specify an option from the Workbench, you add the option to the program’s
"Tool Type" list. To specify an option from the CLI, type a dash (-)
immediately followed by the option as part of the command line. For example,
to run Keystroke Finder with a horizontal display, from the CLI you would
type the command:

"Keystroke Finder" -h

We hope you enjoy using the programs in Quarterback Tools Deluxe!

1.3 Quarterback Tools

Quarterback Tools

Quarterback Tools is an indispensable program that can help you work more
efficiently with your disks, both floppy and hard disks. It can repair
damaged disks, or find and correct problems before they become severe. It
can recover deleted files, and salvage files from badly damaged disks. It
can even speed up the access speed of your disks, so you spend less time
waiting for files and more time working with your computer.

Quarterback Tools can:

* Find and repair problems on your disks, both hard disks and floppy disks.

* Find bad blocks on your disks and mark them as unavailable.

* Recover files that you have accidentally deleted.

* Salvage files on badly damaged disks.

* Optimize disks for improved speed.

* Gives you direct access to the data on your disks.

The following sections describe each of Quarterback Tools’ features. Please
read each section thoroughly before using a particular feature-while
Quarterback Tools is very easy to use, it is also a very powerful program.
By reading each section thoroughly you will learn how to use Quarterback
Tools to its fullest potential.

System Requirements

Quarterback Tools operates on all models of the Amiga computer, as well as
properly designed accelerator cards. Quarterback Tools works with both
floppy disks (both normal and high-density) and hard disks, as well as
removable cartridge disks.

Quarterback Tools requires Kickstart 1.2 or later in order to operate, but
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it works best with Kickstart 2.0 or later. There are several features of
Quarterback Tools that are only available when using this newer version of
Kickstart. Quarterback Tools also works with Kickstart 3.0.

Quarterback Tools requires 512K of memory to work with floppy disks.
However, for working with hard disks you will need at least 1 Meg of memory.
When working with very large hard disks, Quarterback Tools will operate
faster if more memory is available.

1.4 Using Quarterback Tools

Using Quarterback Tools

Quarterback Tools is designed to be very easy to use. This section will tell
you how to install Quarterback Tools on your system, and how to get started
using Quarterback Tools.

Installation

To install Quarterback Tools on your system, simply drag its icon to the
location you wish to install it. In addition, if you are using the AREXX
system, you will need to drag the "Macros" drawer to the same location you
placed Quarterback Tools. By default, Quarterback Tools looks in this
"Macros" drawer for the AREXX macros you execute.

Display Options

Quarterback Tools will normally use the Workbench screen for its window and
requesters. However, you can override this and specify any screen mode and
number of colors that the Amiga is capable of providing. When using
Workbench 2.0 or later, you can even have Quarterback Tools use another
program’s screen if that program declares its screen as "Public".

You specify display options when you first start the program. To specify a
display option from the Workbench, you must add one or more of the following
options to Quarterback Tools’ "Tool type" list. To specify a display option
from the CLI, simply type a dash (-) and the option as a command parameter.
Most options have both an abbreviated and a full form. The options supported
by Quarterback Tools are:

"HighRes" or "HR"
Use a 640 by 400 screen (640 by 512 in PAL).

"MedRes" or "MR"
Use a 640 by 200 screen (640 by 256 in PAL).

"LoRes" or "LR"
Use a 320 by 200 screen (320 by 256 in PAL). Using a low resolution screen
may require the use of shortcuts to access some requester items, as some
requesters may be too large to completely fit the screen.

"Productivity" or "PR"
Use a productivity mode screen (640 by 480 non-interlaced). This option
requires AmigaDOS 2.0 or later, the enhanced chip set or AGA chip set, and
a VGA or multisync monitor. This mode only supports two and four color
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screens.

"SuperHiRes" or "SR"
Use a super high resolution mode screen (1280 by 400). This option requires
AmigaDOS 2.0 or later, and the enhanced chip set or AGA chip set. With the
enhanced chip set, this mode only supports two and four color screens.

"Colors:number" or "Colors=number" or "Colours:number" or "Colours=number"
Where number is 2, 4, 8, 16, or 32, 64, 128, or 256 (you will need the AGA
chip set for 64 or more colors). This command specifies the number of colors
that the screen is to use. Note that on non-AGA Amigas, 32 colors can only
be used with low resolution screens (see the "LoRes" option above).

"Screen:screen name" or "Screen=screen name"
Where screen name is the name of an existing public screen. This option
requires AmigaDOS 2.0 or later, and the presence of a public screen with the
given name. If the specified screen name is not present, Quarterback Tools
will declare the screen it opens to have the specified name. Examples of
screen names are "Workbench" for the Workbench’s screen, and "ProWrite" for
ProWrite’s screen (ProWrite is a word processor from New Horizons Software,
Inc.). This option overrides other screen options. When Quarterback Tools
opens its own screen and you do not specify a screen name, it declares it a
public screen with the name of "Quarterback Tools".

"DumbWindows" or "DW"
Use "simple refresh" (i.e., non-smart refresh) windows. This option makes
window displays slightly slower when dealing with several overlapping
windows, but uses less graphics memory.

"ASL"
Use the "ASL" file requesters for choosing files to open or save. This
option only works with Kickstart 2.0 or later, and only if the
"asl.library" file is installed on your Amiga.

If you are running Quarterback Tools on the Workbench screen with Kickstart
2.0 or later, Quarterback Tools will automatically adjust its window,
requester, and requester sizes to match the Workbench screen font you have
chosen. However, Quarterback Tools’ display is optimized for the Topaz-11
screen font on high-resolution displays, so for the best appearance you
should choose this as your screen font.

Starting Quarterback Tools

You can load and use Quarterback Tools from either the Workbench screen or
from a CLI window.

To load Quarterback Tools:

* Insert your copy of the Quarterback Tools disk into a disk drive.

* From the Workbench: double click on the Quarterback Tools program icon.

* From the CLI: type "Quarterback Tools" (and optionally, any display
options) and press return.

In a few moments, Quarterback Tools will display copyright information on
your Workbench screen, or a screen of its own if you have told it to use a
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custom screen with a start-up parameter. Quarterback Tools will display
this information while it obtains information about your system. Once
Quarterback Tools is done obtaining this information, it will display its
main window.

Quarterback Tools’ main window is divided into two parts: The icon list on
the top, and the volume/device list on the bottom. Quarterback Tools also
has several pull-down menus which contain commands that you can use to
customize and control its operation.

Selecting a Volume or Device

Before you can have Quarterback Tools work on a disk, you must select that
disk from the main window. You can select disks either by volume name or
device name.

To select a disk by volume name:

* Click on the "Volumes" button to have the list show all available volume
names.

* Click on the volume name of the disk you want to have Quarterback Tools
work on.

In the volume list, Quarterback Tools will only show valid, mounted, local
(non-network) AmigaDOS volumes. If a disk is so corrupted that AmigaDOS
cannot mount it, it will not show up in the volume name list-to repair it
you will need to select the device you have inserted the disk into from
the devices list.

To select a disk by device name:

* Click on the "Devices" button to have the list show all available device
names.

* Click on the device name of the disk you want to have Quarterback Tools
work on.

For example, if you insert a badly damaged floppy disk into the first disk
drive on your system, you would select the device named "DF0:" from the
device list.

Once you have selected a disk to work with, you can use any of Quarterback
Tools’ features. These tools are described individually in the following
sections. Once you are finished using Quarterback Tools, either choose
Quit from the Project menu, click in the close box, or press the esc key
to quit using the program.

1.5 Volume and Device Information

Volume and Device Information

With Quarterback Tools you can get detailed information about any AmigaDOS
disk. There are two types of information you can obtain: Volume information
and Device information.
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Volume information is information pertaining to the aspects of the disk
you see through AmigaDOS. This includes the disk’s name, its type of file
system, size, and amount of space available. The volume information that
Quarterback Tools provides also shows you the number of bad blocks that
Quarterback Tools has found and mapped out.

Device information pertains to low-level information about the disk-aspects
you would not normally see through AmigaDOS. This includes the disk’s
device driver and device driver version, location of the volume’s partition
on the disk (if the volume is a partition on a hard disk), and several
device data transfer parameters.

To display volume and device information:

* From the main window, select the volume or device for which you wish to
obtain information.

* Choose Get Volume Information from the Tools menu. A requester will
appear showing the volume information:

* Click on the right arrow button, or press the right cursor key, to
display the device information:

* Click on the left arrow button, or press the left cursor key, to go back
to the volume information.

* Click on the "OK" button when you are finished examining the volume and
device information.

1.6 Analyze and Repair Volume

Analyze and Repair Volume

The "Analyze and Repair Volume" tool can search for and optionally repair a
number of problems on your disks. You can use this tool when you are
starting to have problems with a disk, or as a form of preventative
maintenance, since often it can find and repair problems before they become
severe.

Note:
Quarterback Tools, although quite powerful in its disk repair capabilities,
should not be considered a substitute for regular backups. There are some
types of disk problems-for example physical disk errors-which no program,
not even Quarterback Tools, can repair. In these cases, your data is
simply and irretrievably lost. To recover from these severe problems, your
only recourse is to restore your data from a backup. You should regularly
use a program like Quarterback to keep a current backup of your valuable
data.

There are two types of disk errors you can encounter: Physical errors, and
Logical errors. These two types of problems are discussed below.

Physical Disk Errors

A physical disk error (also called a "Hard" error) occurs when one or more
blocks of data cannot be read from a drive. When a disk has a physical
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error, you will typically start to see messages such as the following:

Volume (name) has a read/write error

Physical errors most often occur on floppy drives or very old hard drives,
and are due to physical defects on the surface of the disk or mechanical
problems in the drive mechanism. Generally, physical errors cannot be
corrected, and the entire block of data (512 bytes) is lost.

The only remedy Quarterback Tools can provide when it encounters a
physical error is to mark the bad block as being "out of service." This
prevents AmigaDOS from using that block for any new files. However, any
file that was previously using that block will no longer be readable
(Quarterback Tools can recover the readable portion of the file, see the
section Recover Lost/Deleted Files later in this chapter).

Logical Disk Errors

A logical disk error (also called a "Soft" error) occurs when a disk block
is readable, but contains the wrong information. If this occurs in a block
that contains AmigaDOS directory information, it may make it difficult or
impossible to access files and drawers on the disk. There are several
different types of messages you might see when a disk has logical errors,
most of them similar to the following:

Key (number) has a checksum error

Logical errors are usually caused by software errors (bugs), either in a
software program or in AmigaDOS itself; but they can also occur if your
computer is shut down or reset while it is in the middle of writing
information to the disk.

Obviously the only guaranteed way to recover from logical errors is to
completely format the disk and restore the contents from a backup.
However, logical errors can almost always be corrected by Quarterback
Tools, unless the errors are so numerous or severe that the original disk
structure is unrecognizable. Even in this case, you can usually use
Quarterback Tools’ Recover Lost/Deleted Files tool to recover your data
before you format the drive. But it is better to be safe than sorry-always
backup your data!

Using the Analyze and Repair Tool

To use the Analyze and Repair tool, you simply select it from the main
window.

To start the Analyze and Repair tool:

* Select the volume or device you wish to repair from the main window.

* Click on the "Analyze and Repair Volume" icon, or choose Analyze and
Repair Volume from the Tools menu. The analyze and repair window will
appear:

You can specify several options for the analyze and repair operation. The
type of operation that is currently specified is shown in the box beneath
the buttons.
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To set repair options:

* Click on the "Options" button, a requester will appear:

* If you wish to scan for bad blocks on the disk and mark them as out of
service (i.e. check for physical errors), turn on the "Bad blocks" check
box, and choose the type of check you would like to perform:

* Choose "reads only" from the pop-up menu if you wish to check blocks for
readability only. This is the fastest method, and will catch nearly all
problems.

* Choose "reads and writes" from the pop-up menu if you wish to perform a
complete usability test on all blocks.

The "reads and writes" test may uncover blocks that are marginally useful
which would have been missed by the "reads only" test, but it will take
over three times as long to complete. Also, under AmigaDOS 2.0 and later,
it is possible to have blocks on floppy disks that are readable but not
writable, so you should turn this option on if you are checking floppy
disks under AmigaDOS 2.0.

* If you wish to check for bad files and drawers on the disk (i.e. check
for logical errors), turn on the "Bad files and drawers" check box.

* If you are checking for bad files and drawers, and wish to check for
readability of data blocks on Fast Filing System (FFS) disks, turn on
the "Check data blocks on FFS disks" check box.

Normally you would leave the "Check data blocks on FFS disks" option turned
off, since checking for bad blocks will find the same errors. (Data blocks
on Old Filing System (OFS) disks will always be checked, since they have
links to the directory blocks that must be examined.) However, if there are
bad blocks in existing files, you should turn this option on to have
Quarterback Tools find and delete the files containing bad blocks.

* To have Quarterback Tools repair the disk as it is checked, turn on the
"Repair drive" check box. Turn this option off if you wish to simply
check the integrity of the disk.

* Click the "OK" button to use the specified options.

Once you have specified the analyze and repair options, you can begin
scanning the disk.

To analyze and repair a disk:

* Click the "Start" button in the Analyze and Repair window. Quarterback
Tools will begin scanning the disk for problems. The progress indicator
will be updated as the disk is scanned.

* If a disk problem is found, it will be displayed in the scroll list. In
addition, if Quarterback Tools is set for interactive mode, a requester
will appear asking you what action you wish to take. A typical error
requester looks like this:
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The top two lines of the requester indicate the location of the problem
(drawer, and drawer entry). The next line indicates the type of error
encountered, and the final line specifies the type of action Quarterback
Tools will take to repair the problem. Depending upon the severity of the
problem, the types of repair operations can range from simply fixing a bad
value to completely deleting the file or drawer.

* Click on the "Repair" button to repair the problem and continue checking
the same file, click on "Ignore" to ignore the problem and continue
checking the same file, click on "Skip File" to skip this file and
proceed with the next file, or click on "Abort" to abort the scanning
process.

Note that if you have turned off the "Repair drive" option, there will be
no "Repair" button and the "Ignore" button will be labeled "Proceed". Also,
in problems that do not involve files (for example, errors in the root
block or in drawer entries), there will not be a "Skip File" button.

* You can pause the scanning at any time by clicking on the "Pause"
button. Click on "Resume" to continue scanning.

* You can abort the scanning at any time by clicking on the "Abort"
button. Note, however, that most problems you request Quarterback Tools
to repair are not actually repaired until the end of the scan (since
Quarterback Tools must make sure the integrity of the drive is intact),
so if you abort the repair operation before it is complete, not all of
the repairs will have been made.

* Once the drive has been completely scanned, Quarterback Tools will
include a summary of the results in the scroll list. If you wish to scan
the disk again, click on the "Start" button.

Occasionally, fixing some logical errors on the disk may create or uncover
other minor problems. Therefore, if problems were found and corrected, it
is usually a good idea to scan the disk a second time.

Once you are finished using the Analyze and Repair tool, click in the close
box or press the esc key to return to the main tool selector window.

1.7 Recover Lost/Deleted Files

Recover Lost/Deleted Files

The "Recover Lost/Deleted Files" tool can search for and recover files
that have either been accidentally deleted, or that may have become
corrupted in such a way that Quarterback Tools’ "Analyze and Repair" tool
is unable to fix. Since this tool can also copy some or all of the files
on a disk to a different disk, you can use it to salvage files from a disk
that is too badly damaged to be fixed by the "Analyze and Repair" tool.

About Deleted Files

When AmigaDOS deletes a file, it does not actually erase the file’s
information. Rather, it simply removes the directory entry for the file
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and marks the file’s blocks as being available for new files. Therefore if
you immediately run Quarterback Tools’ "Recover Lost/Deleted Files" tool
after deleting a file-but before writing anything new to the disk-you
stand an excellent chance of recovering the entire file’s contents.

There is one exception to this situation. If you are using AmigaDOS 1.3 or
earlier, then even the act of deleting a file runs the possibility of
erasing some or all of the file’s contents. The reason for this is that
older versions of AmigaDOS don’t always write the "volume bitmap" to the
same place on the disk. Instead, it places it in any available block.
Since the volume bitmap is written to the disk every time a file is
deleted, there is a chance it will be written to a block that was formerly
used by the file. AmigaDOS 2.0 and later always writes the volume bitmap
to the same location on the disk, so this problem will not occur.

Most other computer operating systems, such as MS-DOS or the Macintosh HFS,
pre-allocate a fixed amount of directory space on the disk and save all
directory information to that one location. AmigaDOS, on the other hand,
only allocates directory space as it needs it. While in some ways this is
more efficient, it also means that directory information on the Amiga can
be located anywhere on the disk. Therefore, to recover deleted files,
Quarterback Tools must scan the entire disk for the directory information.
This can take some time on very large hard drives.

Starting the Recover Tool

To use the "Recover Lost/Deleted Files" tool, you simply select it from
the main window.

To start the Recover tool:

* Select the volume or device you want to scan from the main window.

* Click on the "Recover Lost/Deleted Files" icon, or choose Recover
Lost/Deleted Files from the Tools menu. The recover window will appear:

You can specify several options for the recover operation. These options
can be set either before or after you scan the disk for deleted files.

To set Recover options:

* Click on the "Options" button. A requester will appear:

* If you wish to show only deleted files in the list, turn on the "Show
only deleted files" check box. To show all files on the disk, including
deleted files, turn this check box off.

If you are using Quarterback Tools to simply recover deleted files, you
should leave the "Show only deleted files" option on. Otherwise the
display will show all existing files as well as deleted files, which
could make finding a deleted file difficult.

If you are using Quarterback Tools to salvage files from a badly damaged
disk, you should turn the "Show only deleted files" option off. Then you
can select all of the files on the disk and recover them to a different
volume.

* Turn on the "Show block keys" check box to have the display show the
block number of the file and drawer headers it finds on the disk. This
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is useful for advanced users when using the volume editor to manually
find and repair files. Normally you should leave this option turned off.

* Turn on the "Create replacement drawers" check box to have Quarterback
Tools create drawers for files whose original drawer is completely lost.

When the drawer containing a deleted file is completely lost, Quarterback
Tools creates a drawer on the root of the drive called "Recovered Items"
and places the recovered files in this drawer. If you turn on the "Create
replacement drawers" option, Quarterback Tools will attempt to recreate
as much of the original directory structure for these recovered files as
possible. The drawers it creates to contain the recovered files will also
be placed in the "Recovered Items" drawer. Unless you are recovering a
great many files from "lost" drawers, it is usually simpler to leave this
option turned off.

If there is not enough space to create the "Recovered Items" drawer, the
recovered files will be placed in the root directory.

* Click the "OK" button to use the specified options.

Before you can recover files, you must scan the disk for the files.

To scan the disk:

* Click on the "Scan" button to begin scanning the disk for files.
Quarterback Tools will locate and catalog both existing (non-deleted)
files as well as deleted and lost files, and will display the ones you
have specified in the "Options" requester.

In the file display, existing files and drawers (if you have chosen to
have them displayed) are shown with a white icon and normal text. Deleted
files and drawers are shown with a gray icon and italic text. To the
right of the file names, Quarterback Tools shows the file size, last
modification date, and (optionally) the block number for each file or
drawer.

In addition, next to deleted files is an estimate of the percentage of a
file’s contents that can be recovered. This figure is a maximum, since
it is possible that two deleted files may overlap in their block
allocation. Generally it is not useful to recover a file that is not 100%
recoverable unless it is a text file-programs, picture files, and binary
data files are generally of little use unless they are completely intact.
Quarterback Tools will warn you when it tries to recover a file that is
not 100% recoverable.

Once you have a list of existing and deleted files, you need to "Tag" the
files you want to recover. Quarterback Tools automatically tags all
deleted files when it creates the list, but you can choose to recover
only the files you want.

To tag files for recovery:

* Select a file or drawer by clicking on the file or drawer entry. You
can select more than one file by dragging across the list with the mouse
button down, or by holding down the shift key when you click on the file
or drawer entries. To un-select a selected file or drawer, hold down the
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shift key and click on it again.

* To tag the selected files or drawers, click on the "Tag" button. When a
drawer is tagged, everything inside of the drawer is tagged.

* To untag selected files or drawers, click on the "Untag" button. When a
drawer is untagged, everything inside of the drawer is untagged.

* To tag or untag a single file, double-click on the file entry.

When a file is tagged, a check mark will be shown to the left of the file
icon. When everything in a drawer is tagged, a check mark will be shown to
the left of the drawer icon. When some, but not all, of the files in a
drawer are tagged, a dash will appear next to the drawer icon.

* To tag all items in the display (and all items in drawers shown in the
display), hold down the alt key and click on the "Tag" button. (When
you hold down the alt key, the "Tag" button will change to read "Tag
All".)

* To untag all items in the display (and all items in drawers shown in
the display), hold down the alt key and click on the "Untag" button.
(When you hold down the alt key, the "Untag" button will change to
read "Untag All".)

* To enter a drawer and see its contents, select the drawer and click on
the "Enter" button, or simply double-click on the drawer entry.

* To back out of a drawer and see the previous directory level, click on
the "Back" button.

* To back out of a drawer all the way to the root level of the disk,
hold down the alt key and click on the "Back" button. (When you hold
down the alt key, the "Back" button will change to read "Root".)

Once you have tagged the files you want to recover, you can begin
recovering the files. You can either recover files to the same volume,
or to a different volume.

Recovering to the Same Volume

When you recover files to the same volume, you are essentially
re-attaching a file to the directory structure of the disk. This works
best when a file is completely recoverable, although Quarterback Tools
will do its best to recover as much of a partially recoverable file as
it can. Generally, you should use this method if you are simply
recovering files that you accidentally deleted. If you are trying to
salvage files from a badly damaged disk, you should recover them to a
different volume.

When using this option, you cannot recover existing files, since by
definition they already exist on the disk. Therefore, you should only
tag lost or deleted files before using this recovery method.

To recover files to the same volume:



qbthelp 15 / 52

* Tag the files and drawers you wish to recover.

* Choose "Same volume" from the pop-up menu in the Recover window.

* Click on the "Start" button. The tagged files and drawers will be
recovered to the same volume.

If Quarterback Tools tries to recover a file when a file of the same
name already exists, it will ask you for a different name. When it asks
for a different name, it will suggest a unique name for you. If this
suggested name is satisfactory, you can simply click the "Rename"
button. Alternatively, you can replace the existing file with the one
you are recovering.

Once you have recovered files to the same volume it is a good idea to
use the Analyze and Repair tool to check the volume for problems,
particularly if some of the files were only partially recovered. The
Analyze and Repair tool has much more extensive file integrity checks,
and will ensure that the newly recovered files are intact and properly
linked into the disk directory.

Recovering to a Different Volume

When you recover files to a different volume, Quarterback Tools directly
reads the file information from the disk and writes it to a different
disk. Since it goes directly to the data on the disk, this method is the
best way to recover files from a disk that is so badly damaged that it
cannot be repaired. Generally, you should use this option to recover
files from a disk that you cannot otherwise use, and then format the
drive to make it usable again. Also, this type of recovery does not alter
the source disk in any way, so you should use it if you want to leave the
source disk unaltered.

If you are using this recovery method to salvage the contents of a disk,
you should turn off the "Show only deleted files" option, and tag all
files in the display (both existing and deleted files).

To recover files to a different volume:

* Tag the files and drawers you wish to recover.

* Choose "Different volume" from the pop-up menu in the Recover window.

* In the text box, type the name of the disk or drawer where you want
to save the recovered files. If you specify a drawer name that does
not exist, the drawer will be created.

Be sure to specify a location that has enough space to hold all of the
files you have tagged. Files are untagged as they are recovered, so if
you run out of space while recovering, you can continue where you left off.

* Click on the "Start" button. The tagged files and drawers will be copied
to the location you have specified.

Once you are finished using the Recover tool, click in the close box or
press the esc key to return to the main tool selector window.
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1.8 Optimise Volume

Optimize Volume

The "Optimize Volume" can reorganize the location of directory and file
information on your drives to improve access speed, sometimes dramatically.
You can optimize to improve directory listing access speed at the expense
of file access speed, or vice-versa. You can also use the Optimize tool to
simply get an indication of how fragmented your disk is.

About Optimization

When the Amiga creates files, it does two things:

1. A directory entry is created for the file. This generally takes a
single disk block per file, although very large files may have
several directory blocks allocated.

2. Blocks are allocated to hold the file’s data. Since each block is 512
bytes in size (on FFS volumes), a block is allocated for each 512
bytes or portion in the file. For example, if the file is 5,270 bytes
in size, it will take up 11 blocks-10 for the first 5,120 bytes, and
one for the final 150 bytes. (On OFS volumes, each data block holds
488 bytes. Otherwise, the calculation is the same.)

However, since blocks are allocated from anywhere on the disk, the file’s
directory information is not necessarily anywhere near the data blocks
themselves, and the data blocks may not be located next to each other.
This latter problem is called fragmentation.

When a file’s directory information is located far from the data, the only
affect will be a slow-down in the time required to first access (or "open")
the file. This effect is most evident when using the Workbench with floppy
disks-it will take much longer to display icons in a Workbench window since
the Amiga must access and read the contents of each and every icon file.

When a file’s data is fragmented, it slows down the time required to read
the file’s information. This does not affect Workbench icon display much,
since icons are usually very small files. However, it does affect the
amount of time it takes to load programs and open documents-the things you
do most with your computer.

The Optimize tool can de-fragment your data, resulting in greater speed in
loading programs and opening documents. If a disk is heavily fragmented,
the speed improvement can be quite dramatic. This tool can also re-organize
the file directory information either for improved directory access speed
or improved file access speed. The type of optimization you choose depends
upon the kind of work you do with the files on the disk.

For most disks you should optimize for file access. This will place the
file’s directory information right next to the file’s data, which makes
opening a file much faster. You will notice this most in the Workbench
windows-icons will appear much more rapidly. This is also the method that
AmigaDOS 2.0 and later attempts to use when you first create a file.
However, this method has the drawback of making directory listing speeds
(i.e., the time spent reading the disk when you type "Dir" in a CLI window)
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slightly slower, since the directory information for all of the files in a
drawer is not kept together.

In those rare situations when you spend more time listing the contents of
drawers than actually accessing the contents of files in those drawers,
you should optimize the disk for directory access. This will group all of
the directory information in one place on the disk, making directory
listings faster. However, this will increase the amount of time it takes
to actually access the files-either for Workbench icon display or to load
programs and documents. Also, if you are using AmigaDOS 2.0 or later, the
disk will gradually lose its directory access optimization as you create
and delete files.

No matter which type of optimization you choose, Quarterback Tools will
also coalesce all of the unused space on your drive into a single large
block (or two blocks, if it cannot be merged as one). This will cause any
new files you create to be defragmented as well, so your drive will stay
in a near-optimized state for a longer period of time.

Using the Optimize Tool

To use the "Optimize Volume" tool, you simply select it from the main
window.

To start the Optimize tool:

* Select the volume or device you want to optimize from the main window.

* Click on the "Optimize Volume" icon, or choose Optimize Volume from the
Tools menu. The Optimize window will appear:

The Optimize window initially displays a map showing the allocated and
free blocks on the selected volume, along with a count of the number of
contiguous allocated blocks. While this does not directly tell you the
amount of fragmentation that exists on the volume, if there are a large
number of "holes" in the used disk space it usually means that the volume
is fragmented.

You can use the Optimize tool to directly tell you the number of
fragmented files, as well as use it to optimize the volume for either
file access or directory access. To do this, you need to set the Optimize
options.

To set Optimize options:

* Click on the "Options" button. A requester will appear:

* Select the "Count fragmented files only" option if you simply wish to
count the number of fragmented files in the volume.

* Select the "Optimize disk" option if you want to optimize the volume.
You can also specify the type of optimization to perform:

* Choose "file access" from the pop-up menu to optimize for file access.

* Choose "directory access" from the pop-up menu to optimize for
directory access.

* Click the "OK" button to use the specified options.
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Once you have specified the optimize options, you can begin the
optimization.

Warning:
MAKE SURE YOU HAVE A CURRENT BACKUP OF THE INFORMATION ON YOUR DRIVE
BEFORE USING THE OPTIMIZATION TOOL. During optimization, the contents of
the disk are in a highly unpredictable state. If optimization is
interrupted for any reason, such as a power outage or accidental reset,
some or all of the contents of the disk may be unrecoverable. Also, you
should not run any other programs on your computer while you are
optimizing. If another program crashes your computer in the middle of
optimization, the contents of your disk could be lost.

Another reason to have no other program running during an optimization
is that the more memory available to Quarterback Tools, the faster the
optimization can go.

To optimize a volume:

* Click on the "Start" button. Quarterback Tools will scan the volume
and count the number of fragmented files.

* Once the volume has been scanned, Quarterback Tools will verify that
there are no problems with the drive and report the number of
fragmented files. If you have enabled optimization, Quarterback Tools
will then ask you if you wish to proceed.

* Click the "Yes" button to begin the optimization.

* While the disk is being optimized, the display will be updated to show
the current state of the volume and the completion percentage.
Quarterback Tools will also display a rough estimate of time to
completion in hours, minutes, and seconds.

On large drives (over 100 megabytes), depending upon the speed of your
Amiga and hard drive, optimization can take over an hour. You must leave
your Amiga undisturbed during the optimization. Quarterback Tools will
report when optimization is complete.

While optimizing, Quarterback Tools will work around any "bad.blocks"
file that was created by the Analyze and Repair tool. On disks with bad
blocks, this may result in some slight fragmentation remaining after
optimization is complete.

AmigaDOS often keeps references in memory to locations on the disk. After
optimizing, these locations will have changed without AmigaDOS’s
knowledge. If AmigaDOS were to attempt to access the disk with these
incorrect in-memory references, the contents of the disk could be
corrupted. To avoid this, Quarterback Tools will keep AmigaDOS from being
able to access the newly optimized disk until you restart your computer.
This will ensure that the drive contents are not accidentally corrupted.

Note:
When AmigaDOS creates files, it writes them starting from the middle of
the drive outward. When the end of the drive is reached, it continues from
the beginning up to the middle. This is done so that as much data as
possible is located near the root of the drive (which is in the middle),
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and Quarterback duplicates this method when optimizing files. However, it
has the drawback that you will most likely have one file that is
fragmented-the one that crosses from the end of the drive to the
beginning-even after optimizing the drive. This fragmentation is very
minor (a single file will be fragmented in one place), but Quarterback
Tools will still report it to you if you re-scan the drive after optimizing.

After optimizing, remnants of the older, invalid directory information may
remain in unallocated blocks. These directory entries will look like
deleted files to Quarterback Tools’ Recover tool, when in fact they are
not recoverable. It is a good idea to run the Disk Eraser tool to erase
the free space on the disk to eliminate these invalid entries.

Once you are finished using the Optimize tool, click in the close box or
press the esc key to return to the main tool selector window.

1.9 Edit Volume

Edit Volume

For advanced users, Quarterback Tools includes a disk sector editor. This
editor allows you to directly examine and modify the contents of any
sector on a disk.

The volume editor is very useful for examining the contents of a disk,
either as an aid to learning the low-level structure of the AmigaDOS
filing systems, or simply as a means of browsing your disks. If you are
very familiar with the AmigaDOS disk data structures, you can also use
the editor to fix problems that Quarterback Tools cannot. For example, if
two files are linked to the same data blocks, Quarterback Tools cannot
effectively repair the problem since it has no way of knowing which file
the data belongs to. However, with the volume editor you can examine the
file contents directly and determine which file to link the data to.

To fully understand the volume editor, you will need to be familiar with
the low-level disk structures used by AmigaDOS. However, a full discussion
of these structures is beyond the scope of this manual; you should refer
to The AmigaDOS Manual, available from your local bookstore, for a
complete discussion of this topic.

Note that the AmigaDOS documentation often refers to block numbers as
"Key" numbers. Also, in the discussion below, the terms "block" and
"sector" are used interchangeably.

Warning:
Since the volume editor gives you direct access to the contents of a disk,
it is possible for you to do a great deal of damage to your disks unless
you know what you are doing. Exercise care when using the volume editor.
In particular do not use the "Write" command unless you are sure of the
changes you have made.

Starting the Volume Editor

To use the volume editor, you simply select it from the main window.



qbthelp 20 / 52

To start the volume editor:

* Select the volume or device you wish to edit from the main window.

* Click on the "Edit Volume" icon, or choose Edit Volume from the Tools
menu. The editor window will appear:

If the volume you have selected is an AmigaDOS volume, the editor will
first show the root block. If it is not an AmigaDOS volume, the first
sector on the volume will be shown.

The editor window has several controls and information indicators in its
window: Across the top is a slider and left/right arrow buttons that
control which block is shown. Below and to the left is the number of the
block you are looking at, you can use the pop-up menu to choose between
displaying the block number in decimal or hexadecimal. To the right of
the block number are buttons for controlling reading, writing, and moving
to blocks on the volume. Below the block number is an indicator of the
type of block you are looking at. To the right of the block type is a
small circle which is filled in if the block being edited is allocated in
the volume bitmap. Finally, in the lower right is an indicator of the type
of field in the block that the cursor is on. These indicators and controls
will be more fully explained below.

When the editor is active, a new menu, the Edit menu, will be added to the
menu bar. These commands will be explained in the following sections.

Below the indicators and controls is the block display. It displays the
contents of the block both in hexadecimal on the left, and in ASCII on
the right. If the window is too small to show the entire block, you can
use the up and down scroll arrows and scroll bar to scroll the contents
up or down.

Traversing the Volume

Once you have started the volume editor, the first thing you will want to
do is go to a particular block on the volume. There are numerous ways
provided to do this.

To go to particular blocks:

* Click on the left and right block arrows at the top of the window, or
press the left and right cursor keys. Blocks will be read and displayed
sequentially until you release the mouse button or cursor key.

* Drag the block slider at the top of the window. When you release the
mouse button, the corresponding block will be read and displayed. If
you hold down the alt key when you drag the slider, blocks will be read
and displayed as you drag.

* To go to a specific block number, choose Go To Block from the Edit menu,
type the number of the block you want to go to, and click the "OK" button.

* If the block number is displayed in the edit window (for example, a hash
table entry in a directory block, or a data key in a file header block),
you can go to that block by clicking on the block number in the display,
then clicking on the "Go" button, or by simply double-clicking on the
block number.
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* To go back to the previous block you were displaying, choose Go To
Previous from the Edit menu.

* To go to special blocks on the volume, choose the type of block from the
Go To submenu on the Edit menu. The type of block you can go to depends
upon the type of block you are currently displaying:

You can always go to the Root and first Bitmap blocks on valid
AmigaDOS volumes.

You can go to the Hash Chain block when you are in a file header
or drawer block that has a non-null hash chain entry.

You can go to the Parent block when you are in a file header,
drawer, or directory-cache block.

You can go to the Extension block when you are in a file header or
file extension block that has a non-null file extension entry, or
in a directory-cache block with a non-null next block entry.

You can go to the Header block when you are in a data block on an
"Old Filing System" (OFS) volume (data blocks on "Fast Filing
System" (FFS) volumes do not have header block entries).

You can go to the Next Data block when you are in a file header
block that has a non-null data block entry. You can also go to the
Next Data block when you are in a data block on an OFS volume.

The type of block you are displaying-for example, "Root", "Bitmap", "Data",
and so on-will be indicated in the "Type:" box. In addition, if the block
is allocated in the volume bitmap, the circle next to the "Type:" box will
be filled-in.

Searching the Volume

You can search all or part of a volume for a particular item of information.

To search a volume:

* Choose Find from the Edit menu. A requester will appear:

* From the pop-up menu, choose the type of entry you would like to make
and type the entry:

* To search for an ASCII text string, choose ASCII from the pop-up menu
and type an ASCII text string in the text box.

* To search for a hexadecimal value, choose Hex from the pop-up menu and
type a hexadecimal value. The hexadecimal value must be an even number of
digits (if an odd number of digits is entered, a zero will be added to
the beginning of the entry).

* To search for particular hex values from fields in the current block,
choose the appropriate item from the pop-up menu (Current Key, Parent
Key, or Header Key). The appropriate value will be automatically placed
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in the text box.

* To have Quarterback Tools ignore bad blocks during the search, turn off
the "Warn on each bad block" check box.

* Select the search direction, either "Forward" or "Reverse".

* Select the block range to search, either "All" or a starting and ending
block number.

* Click the "Find" button to start the search.

* After the first occurrence of the data is found, choose Find Next from
the Edit menu to search for the next occurrence.

Editing a Block

You can edit a block’s data either as hexadecimal numbers or ASCII
characters, and write the modified block back out to the disk.

To edit a block’s data:

* Click on of the data you wish to modify, either in the hexadecimal or
ASCII side of the display. A cursor will appear at the character you
clicked on. In addition, a rectangle will be drawn around the long-word
(four bytes) that contains the cursor. The type of field the rectangle
is surrounding will be indicated in the "Field:" box.

* Type the new information. If you are editing the hexadecimal side of the
display, you can only type valid hexadecimal characters (the numbers
0-9 and characters A-F). In the ASCII side, every character you type
(except the enter key) will be entered as ASCII data.

* Use the up, down, left, and right cursor keys to move around the display.

* When editing in the hexadecimal side, use the tab and shift-tab keys to
move forward and backward by a long-word (four bytes).

* You can switch between edit modes (non-edit, edit hexadecimal, and edit
ASCII) by pressing enter and shift-enter.

* Once you have finished making changes to the block, click on the "Write"
button to write the changes to the disk. Be careful to only write data
that you are sure is correct, otherwise you may corrupt your disk! (So
that you don’t accidentally select the "Write" button, the "Write"
button has no key equivalent.)

* If you decide not to change the block’s contents, click on the
"Re-Read" button to forget your changes and re-read the block from the
disk. (So that you don’t accidentally select the "Re-Read" button, the
"Re-Read" button has no key equivalent.)

All blocks on Old Filing System disks, and all non-data blocks on Fast
Filing System disks, have a "Checksum" field that must be correctly
filled in order for AmigaDOS to read the block. With the volume editor
you can either manually update the checksum field, or have it
automatically updated whenever you write the block to the disk.
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To adjust the checksum:

* To have the checksum automatically adjusted when you write a block to
the disk, turn on the Auto-Adjust Checksum command in the Edit menu. A
checkmark will appear next to the menu item when it is turned on.
(Quarterback Tools’ default is to have auto-adjust turned on.)

* To manually force an update of the checksum before you write a block to
the disk, choose Adjust Checksum from the Edit menu.

Note that the Adjust Checksum and Auto-Adjust Checksum commands are only
enabled when you are editing an AmigaDOS volume. If you are editing any
other type of disk (such as a Kickstart disk), these commands are not
available.

In the root block and directory blocks, AmigaDOS maintains a hash table
for all filing system entries. The volume editor can automatically
position the cursor on the hash table entry for a particular file or
drawer name.

To position the cursor in the hash table:

* Make sure you are in the root or a directory block.

* Choose Calculate Hash from the Edit menu. A requester will appear:

* Type in the file name and click the "OK" button. The cursor will be
positioned on the hash table entry for the specified file name.

Capturing Data

You can use the volume editor to capture information from any place on a
disk and save it to a file. This is useful for recovering information
from a disk that is so badly damaged that even Quarterback Tools is
unable to work with it.

To capture information to a file:

* Choose Create Capture from the Edit menu. The "Save As" requester will
appear where you can specify a location and name for the capture file.

* When you are viewing a block that you wish to add to the capture file,
choose Write To Capture from the Edit menu. The block will be appended
to the capture file you have created. Note that on OFS volumes, only
the 488 bytes in the data portion of a block will be written.

* When you are finished capturing information from the disk, choose Close
Capture from the Edit menu.

Since Quarterback Tools keeps the capture file open until you tell it to
close the file, if you open a capture file it is important to choose
Close Capture before you restart your system. Otherwise not all of the
information you have captured may be saved to the file. (If you leave the
editor or quit from Quarterback Tools, the capture file will be closed
automatically.)

Once you are finished using the volume editor, click in the close box or
press the esc key to return to the main tool selector window.
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1.10 Saving and Printing Information

Saving and Printing Information

In addition to viewing the information in the "Analyze and Repair Volume"
window, the "Recover Lost/Deleted Files" window, or the "Edit Volume"
window, you can save and print this information as well.

To save a window’s information:

* Choose Save As from the Project menu. A requester will appear.

In the file list, file names are shown in normal type, drawer names are
shown in italics and are preceded by a dash "-".

The "Enter", "Back", and "Disks" buttons can be used to go to the drawer
where you wish to save the file. Click on a drawer name and then on the
"Enter" button, or simply double-click on the drawer name, to list the
files in that drawer. Click the "Back" button to back out of the current
drawer and list the files in the "parent" drawer. Click on "Disks" to
display a list of disks to enter.

* Specify a location to save the information by using the "Enter", "Back"
or "Disk" buttons.

* Type a file name for the information you wish to save by typing in the
text box.

* When you have chosen the format and name for the file, click on the
"Save" button to save the file.

You can also print the catalog or session log you are viewing. Before
printing, it may be necessary to set the page format you wish to use. If
you do not specify a page format, Quarterback Tools will use its current
default settings.

To specify the page format:

* Choose Page Setup from the Project menu. A requester will appear.

* Select the paper size from the list presented. The possibilities are
"US Letter", "US Legal", "A4 Letter" (an international letter size),
and "Wide carriage" (for wide-platen printers). A "Custom" option is
also available, with associated text boxes for entering a custom page
size in inches (or centimeters if you have the unit of measurement set
to centimeters).

* Select the printer pitch you want to use. The choices are "Pica" (10
cpi), "Elite" (12 cpi), or "Condensed" (approximately 17 cpi on most
printers). Note that some printers use a different pitch for "Condensed"
than what Quarterback Tools expects, which may affect the output quality
when using this pitch.

* Select the line spacing you want to use. The choices are "6 lpi" or
"8 lpi".

* Select the unit of measurement you want to use for the "Custom" page
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size. The choices are "Inches" or "Centimeters".

* Select or deselect the "No Gaps Between Pages" option, as desired. When
turned off, Quarterback Tools will not print on the top or bottom 1/2
inch of the page.

* Click on the "OK" button to set the page format.

Once you have set the page format, you can print the information.
Quarterback Tools can print either in "NLQ" or "Draft" modes. NLQ mode
will give you the best quality output, but is slower than Draft mode.
Also, some printers are not capable of printing Condensed pitch in NLQ mode.

To print the information in a window:

* Make sure your printer is properly connected to your computer and turned
on.

* Make sure the paper is properly positioned in the printer. If you have
the "No Gaps Between Pages" option in the "Page Setup" requester turned
off, then position the top edge of the paper 1/2 inch above the top of
the print head. If you have this option turned on, position the top edge
of the paper at the top of the print head (so the first line printed
will be on the very top of the page).

* Choose Print from the Project menu. A requester will appear.

* Select the print quality you want, either "NLQ" or "Draft".

* If you want more than one copy of your document, type the number of
copies in the "Copies" text box.

* Specify whether you will be using "Automatic" or "Hand feed" paper feed.
If you select "Hand feed" you will be prompted for the next sheet of
paper whenever each page finishes printing.

* Set the desired printer font number. This number’s meaning depends on
your printer driver, and not all printer drivers currently support it.

* If you wish to print the document to a file, select "File" as the
destination.

* Click on the "Print" (or "Save") button to begin printing. If you are
printing to a file, the "Save As" requester will appear where you can
specify the name and location of the file you are creating.

When printing begins, a requester will appear allowing you to cancel the
printing at any time.

When printing to a file, Quarterback Tools saves all printer control
sequences as Amiga printer commands, not as the destination printer’s
commands. This means that to print the file you have created, you must
copy it to "PRT:" rather than "PAR:" or "SER:".

1.11 Preferences and Program Settings
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Preferences and Program Settings

Quarterback Tools has several general options you can set that apply to
all parts of the program. In addition, you can save and load all program
settings at one time, and specify defaults for all program settings.

Preferences

In addition to the various options available in each window, there are
several other more general settings you can make to customize Quarterback
Tools to your own preferred way of operation.

To set general preferences:

* Choose Preferences from the Project menu. A requester will appear.

* Indicate how whether you would like block numbers displayed in
hexadecimal or decimal by selecting the appropriate option.

* Set the type of interaction you would like, either "Interactive" or
"Quiet". When "Interactive" mode is enabled, Quarterback Tools will
stop to ask you to proceed before making any alterations to a disk. In
"Quiet" mode, Quarterback Tools will simply list the problem in the
scroll list, and automatically repair the problem if "Repair" is
turned on-it will only stop and warn you if a severe problem is
encountered which cannot be fixed.

* Indicate how you would like to have Quarterback Tools notify you of
problems, either by flashing the screen and/or making a beep sound, by
turning on or off the "Flash screen" and "Beep sound" check boxes.

* To have Quarterback Tools create icons when it saves files, turn on the
"Save icons with Quarterback files" check box.

* To have Quarterback Tools avoid making any calls to AmigaDOS routines
for the selected drive, turn on the "Bypass AmigaDOS" check box.

Note:
Normally you should leave the "Bypass AmigaDOS" option turned off, as it
limits some of Quarterback Tools’ operations. Turn this option on only in
the rare circumstances where Quarterback Tools locks up when you try to
analyze, repair, or edit a disk (this can happen when a disk is so badly
damaged that the Amiga system itself locks up when any attempt is made to
access the disk).

* Click on the "OK" button when you have finished setting your preferences.

Program Settings

With Quarterback Tools, you can save all of the settings you have made in
all of the requesters. You can either save these settings as your defaults,
so they will be automatically set whenever you start Quarterback Tools, or
as separate "Settings" files that you can load at a any time.

To save program settings:

* Set all of Quarterback Tools’ settings and preferences the way you want
them.
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* Choose Settings / Save As from the Project menu. The "Save As" requester
will appear.

* Specify a name and location to save these settings, and click on the
"Save" button.

You can load Quarterback Tools’ settings at any time.

To load program settings:

* Choose Settings / Load from the Project menu. The "Load" requester will
appear. It operates in a very similar fashion to the "Save As" requester.

* Select the settings file you wish to load and click on the "Open" button.

When Quarterback Tools starts up, it looks for a settings file with the
name "QBT Settings" in the same location as the Quarterback Tools program.
If this file is found, Quarterback Tools automatically loads these settings.
You can have Quarterback Tools automatically create this file for you.

To create a default settings file:

* Choose Settings & Save from the Project menu, and click on the "Yes"
button to create the default settings file.

1.12 Macros and AREXX

Macros and AREXX

Quarterback Tools includes a facility which allows you to create "macro"
programs using the AREXX programming language. Macros allow you to automate
repetitive operations with Quarterback Tools, giving you the ability to
simplify working with Quarterback Tools and customize your work environment.
You must have AREXX installed on your system in order to use Quarterback
Tools’ macros (AREXX is included as part of AmigaDOS 2.0 and later).

Creating and Using Macros

A macro program consists of a series of normal Quarterback Tools commands.
Once created, a macro can be executed as though it was a single
command-either by choosing an item from the Macro menu or by holding down
the shift key and pressing a function key.

Macros are normally considered to be a feature for "advanced" users. To
use them, you must have the AREXX language system installed on your Amiga,
and you should have some familiarity with the language. For additional
information about AREXX, refer to the AREXX manual that came with your
AREXX system.

To create a macro:

* Use a text editor (such as the CLI’s "Ed") to write the macro program.
A complete listing of Quarterback Tools’ macro language commands appears
later in this section. Here is an example of a simple macro program:

/* Optimize disk in DF0: for file access */
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SetDevice DF0:
Optimize
OptimizeOptions CheckAndOptimize FileAccess
Start

Note that the first line of an AREXX program must be a "C style"
comment (it must start with "/*" and end with "*/").

* Save the macro program as a "Text Only" (or "ASCII") file in the drawer
named "Macros" where Quarterback Tools is located. You may give the
macro any name you like.

You can invoke Quarterback Tools macros either with they keyboard or the
menu. And because Quarterback Tools’ macros run through AREXX, you can
also start up a Quarterback Tools macro from a program other than
Quarterback Tools.

Quarterback Tools opens an AREXX "port" named "QB_Tools". However, you do
not need to reference this port name unless you are invoking AREXX macros
from outside of Quarterback Tools. If you are running two or more copies
of Quarterback Tools simultaneously, the second instance of Quarterback
Tools will open a port named "QB_Tools.1", the third a port named
"QB_Tools.2", and so on.

To use a macro:

* Before using macros, you must start up the AREXX resident process with
the language’s "RexxMast" CLI command. This command should be included
in your system’s startup sequence. See your AREXX documentation for
details.

* If you have customized Quarterback Tools’ Macro menu to include your
macro name (see later in this section for information about customizing
the Macro menu), simply choose the corresponding command from
Quarterback Tools’ Macro menu, or hold down the shift key and press the
corresponding function key. The commands in the macro file will be
executed.

* For other macro programs, or to give a parameter to your macro, choose
Other from the Macro menu. A requester will appear where you can type
the macro’s name and specify an optional parameter.

* AREXX programs which are run externally, either using AREXX’s "rx" CLI
command or another AREXX-compatible program, may also send commands to
Quarterback Tools. AREXX programs that are started in this way must
have an "Address ’QB_Tools’" command line before any Quarterback Tools
macro commands in order to for Quarterback Tools to receive the AREXX
commands.

Macro Parameters

You can pass parameters to your macros when you invoke them from
Quarterback Tools. You can use macro parameters as a way of sending your
macro additional information that it can use when executing your command.

To send a parameter to a macro:

* Choose Other from the Macro menu. A requester will appear.
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* Type the name of the macro you wish to execute, press return, and type
the parameter you wish to have sent to the macro. If the macro program
is not in Quarterback Tools’ "Macros" drawer, you can click on the "?"
button and use Quarterback Tools’ "Load" requester to locate the macro
you wish to execute.

* Click on the "Execute" button to execute the macro.

Your macro programs can retrieve the parameter passed to them by using
the ARG( ) AREXX command. For example:

numParams = ARG()

will return in the variable "numParams" the number of parameters passed to
the macro (zero or one), and

parameter = ARG(1)

will return the parameter sent to the macro.

Macro Menu Customization

You can customize the macro names in the Macro menu. When you change a
macro name in the menu, you also change the corresponding shift-function
key command equivalent.

To customize the Macro menu:

* Choose Customize from the Macro menu. A requester will appear.

* Change the macro names for each of the ten entries to the names of the
macros you wish to use.

* Click on the "Use" button to use the new macro names without making them
the default settings. Click on the "Save" button to use the new settings
and also save them as your default macro menu settings.

When you save your macro name settings, Quarterback Tools creates a file
named "QBT FKeys" in the same drawer as Quarterback Tools. Quarterback
Tools will look for this file when it starts up, and will set the macro
menu to the settings it contains.

Remember that you must hold down the shift key when you press a function
key in order to invoke a macro from the Macro menu. Pressing a function
key without holding down the shift key will execute a menu command instead.

Other Macro Features

When Quarterback Tools first starts up, it will automatically execute the
AREXX macro named "QBT Startup" if one is present in Quarterback Tools’
"Macros" drawer.

Note that there is no way for the AREXX port in Quarterback Tools to
respond to requesters. If any command causes Quarterback Tools to display
a requester, the user must acknowledge the requester before the macro can
continue.

Quarterback Tools will report errors and failures of macro commands. If a
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command has improper parameters, Quarterback Tools will set the AREXX
variable RC to 5. If a macro command fails, Quarterback Tools will set
RC to 10. Finally, if a command is sent to Quarterback Tools that it does
not understand, Quarterback Tools will set RC to 20.

If Quarterback Tools is started from the CLI, it will display diagnostic
messages in the CLI window whenever it detects errors in a macro program.
These messages will not appear if Quarterback Tools was started from the
Workbench.

Macro Language Commands

Quarterback provides the following commands for use by macro programs.

Project menu commands:
About Displays the "About Quarterback Tools" requester.
SaveAs (filename) Displays the "Save As" requester to save the

information in a window. If a filename is supplied,
the information will be saved to the specified file.

PageSetup Displays the "Page Setup" requester.
Print Displays the "Print" requester to print the

information in a window.
Preferences Displays the "Preferences" requester.
Quit Quits Quarterback Tools.

Tools menu commands:
Tools Returns to the main tool selector window.
Repair Invokes the "Analyze and Repair" tool for use on

selected volume or device.
Recover Invokes the "Recover Lost/Deleted Files" tool for

use on selected volume or device.
Optimize Invokes the "Optimize" tool for use on selected

volume or device.
Edit Invokes the "Edit" tool for use on selected volume

or device.
GetVolumeInfo Displays the "Volume Information" requester for

selected volume or device.
GetDeviceInfo Displays the "Device Information" requester for

selected volume or device.

Volume/device selection commands:
SetDevice (devicename)
Selects specified device or changes to device selection mode.

SetVolume (volumename)
Selects specified volume or changes to volume selection mode.

Options commands:
Preferences (options)

If no options are specified, displays the "Preferences" requester.
Otherwise sets preferences options, where options are one or more of:

Hex Decimal
Interactive Quiet
BeepOff BeepOn
FlashOff FlashOn
SaveIconsOff SaveIconsOn
BypassDOSOff BypassDOSOn
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RepairOptions (options)
If no options are specified, displays the "Repair Options" requester
if using the "Analyze and Repair" tool. Otherwise sets repair
options, where options are one or more of:

BadBlocksOff BadBlocksOn
ReadsOnly ReadsAndWrites
BadFilesOff BadFilesOn
CheckFFSDataOff CheckFFSDataOn
RepairOff RepairOn

RecoverOptions (options)
If no options are specified, displays the "Recover Options"
requester if using the "Recover Lost/Deleted Files" tool. Otherwise
sets recover options, where options are one or more of:

ShowDeleted ShowAll
ShowKeysOff ShowKeysOn
CreateDrawersOff CreateDrawersOn
ToSameVolume ToDifferentVolume (volumename)

OptimizeOptions (options)
If no options are specified, displays the "Optimize Options"
requester if using the "Optimize" tool. Otherwise sets optimize
options, where options are one or more of:

CheckOnly CheckAndOptimize
DirAccess FileAccess

Other commands:
Start Starts the current operation. This command is equivalent to

pressing the "Start" button in the "Analyze and Repair
Volume", "Recover Lost/Deleted Files", and "Optimize
Volume" windows.

ProgName Returns the name "Quarterback Tools" in the AREXX variable
"result".

ProgVersion Returns the Quarterback Tools version number in the AREXX
variable "result".

ScreenToFront Brings the Quarterback Tools screen to the front.

ScreenToBack Sends the Quarterback Tools screen to the back.

SetPrint (options) Sets print options, where options are one or more of:
NLQ Draft
AutoFeed HandFeed

PrintOne Immediately print the information in the window without
displaying the "Print" requester.

SetPath path Set the current directory path to specified path name.

Request1 info Displays a requester with specified information text and a
single "OK" button. Sets AREXX variable RC to 0.

Request2 info Displays a requester with specified information text and
two buttons labeled "OK" and "Cancel". Sets the AREXX



qbthelp 32 / 52

variable RC to 0 if "OK" is pressed, and to 1 if "Cancel"
is pressed.

Request3 info Displays a requester with specified information text and
three buttons labeled "Yes", "No", and "Cancel". Sets the
AREXX variable RC to 0 if "Yes" is pressed, to 1 if
"Cancel" is pressed, and to 2 if "No" is pressed.

RequestText info Displays a requester with specified information
text, a text box for user entry, and two buttons labeled
"OK" and "Cancel". Sets the AREXX variable RC to 0 if "OK"
is pressed, and to 1 if "Cancel" is pressed. If "OK" is
pressed, also sets the AREXX variable "result" to the text
box contents entered by the user.

1.13 Miscellaneous

Miscellaneous

This section contains some additional information that will help you get
the most out of Quarterback Tools.

Workbench 2.0 Features

Quarterback Tools provides several additional features when you are using
Workbench 2.0 or later. The main improvements are the "Application Icon"
or "AppIcon" and "Application Menu Item" or "AppMenuItem" features.

When Quarterback Tools is started on a Workbench 2.0 system, it will put
an AppIcon named "QBT Deposit" on the Workbench screen. If you double-click
on this icon, Quarterback Tools will bring its screen and window to the
front. If you drag a Quarterback Tools settings file onto this icon, that
settings file will be loaded.

Quarterback Tools also adds an AppMenuItem named "Quarterback Tools" to the
Workbench "Tools" menu. When you choose this menu item, Quarterback Tools
will bring its screen and window to the front. If you are running
Workbench 2.04 or later, then when you select a settings file before
choosing this menu command, Quarterback Tools will load the settings file
just as if you had dragged that icon over the "QBT Deposit" icon.

Quarterback Tools also supports the file and directory links that are new
to AmigaDOS 2.0.

Workbench 3.0 Features

When using Quarterback Tools with Workbench 3.0, Quarterback Tools will use
the Preferences "Busy" pointer rather than its own, allowing you to
customize the pointer appearance.

Quarterback Tools also supports the new "International" and
"Directory-Cache" filing systems that are new to AmigaDOS 3.0.

About the Directory-Cache filing system:
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The new Directory-Cache filing system in AmigaDOS 3.0 was designed to speed
floppy usage. However, for several reasons, we do not recommend using this
filing system, either on floppy disks or hard disks:

* It is not useful on hard disks since it does not noticeably increase hard
disk directory access speed.

* It reduces the space available on a disk-a minimum of 0.5K bytes is used
for every drawer on the disk. On hard disks with numerous drawers, this
can add up to more than several hundred thousand bytes lost.

* These disks cannot be read by any Amiga that is not running AmigaDOS 3.0
or later-so you cannot use these disks to transfer files to anyone who
does not have this version of the system.

* It actually slows down many file operations, like creating, deleting, and
updating files.

* Because more directory information is kept on the drive, there are more
ways for the drive to become corrupted. For example, if the directory
cache does not match the actual directory, it is possible to have files
shown in the directory listing that do not exist on the drive.

Function Keys

You can use the function keys to access several Quarterback Tools features:

Function Key Command

F1 Get Volume Information
F2 Get Device Information
F3 Save As
F4 Page Setup
F5 Print
F6 Select "Analyze and Repair Volume" tool
F7 Select "Recover Lost/Deleted Files" tool
F8 Select "Optimize Volume" tool
F9 Select "Edit Volume" tool
F10 Return to main tool selector window
help About Quarterback Tools
shift-help Preferences

As mentioned in the section "Macros and AREXX," holding down the shift key
and pressing a function key will invoke a Quarterback Tools macro. See that
section for more information.

1.14 Replicator

Replicator

Replicator is a program for quickly and easily making copies of your
floppy disks. With Replicator you can make multiple copies at the same
time (up to four at a time, depending upon how many floppy drives you have
attached to your system), and even make disk "images" that you can save on
your hard drive for later use. There are several options for controlling
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the duplication process, including disk verification and whether you wish
to make each disk unique. All together, Replicator makes a very capable disk
duplication system on your Amiga.

Replicator can duplicate just about any Amiga disk format, including normal
Amiga disks (880K), high-density disks, and 5-1/4" Amiga disks (although
these are relatively rare). Replicator cannot duplicate non-Amiga disks,
such as IBM PC or Macintosh disks.

When replicating disks, Replicator first loads the entire disk image into
memory. It then writes out the number of copies you specify. To use
Replicator you will therefore need to have enough available memory in your
Amiga to hold an entire disk image. This is approximately 880K for a normal
Amiga disk, and twice that for a high-density disk.

To start Replicator and load a disk image:

* Start Replicator from the Workbench or CLI. Its window will appear:

* Click on the "Load Image" button. A requester will appear:

* If you wish to load an image from an existing floppy disk, select the
drive from which you wish to load it from the pop-up menu. Only available
floppy drives will be shown in the pop-up menu.

* If you wish to load an image from a previously saved image file, select
the "File" option and type the location and name of the image file in the
text box. Alternatively, you can click on the "?" button and use the
"Load File" requester to locate and specify the image file you wish to
load.

File names are shown in the "Load File" requester in normal type, drawer
names are shown in italics and are preceded by a dash "-".

The "Enter", "Back", and "Disks" buttons can be used to go to the drawer
containing the file you wish to load. Click on a drawer name and then on
the "Enter" button, or simply double-click on the drawer name, to list the
files in that drawer. Click on the "Back" button to back out of the current
drawer and list the files in the "parent" drawer. Click on the "Disks"
button to display a list of disks to enter.

* Click on the "Load" button to load the specified image. If you are
loading an image from a floppy disk, you will be asked to insert the disk
into the chosen drive.

Once you have loaded a disk image, you can save it as a disk file on your
hard disk so that you can quickly load it at a later time.

To save a disk image:

* Click on the "Save Image" button. The "Save File" requester will appear.
This requester operates identically to the "Load File" requester
described above.

* Specify the name and location to which you wish to save the image file,
and click on the "Save" button.

Before you begin replicating, you will need to specify the number of
copies you wish to make.
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To specify the number of copies:

* Turn on the check boxes for the floppy drives you wish to use during
replication.

* Select the "Number" option and click on the up and down arrow buttons (or
use the up and down cursor keys) to specify the number of passes you wish
to make. The total number of copies is equal to the number of passes
times the number of floppy drives you are using.

* Select the "Unlimited" option to have Replicator continue to make
duplicates until you tell it to stop.

Now you are ready to replicate.

To make disk copies:

* Click on the "Start" button to begin replication. You will be prompted to
insert and remove disks at the appropriate time. It is particularly
important to remove the disks when asked if you have turned off the
"Make Each Copy Unique" option (described below).

* You can stop a replication pass at any time by clicking on the "Stop"
button, and you can cancel the replication entirely by clicking on the
"Cancel" button when asked to insert new disks. If you have specified an
unlimited number of passes, this is the only way to stop replicating.

* To quit from Replicator, click in the close box or press the esc key.

There are several options you can set in Replicator to control the
replication process.

To set Replicator options:

* Click on the "Options" button. A requester will appear:

* Turn on the "Verify After Write" check box to have Replicator read and
verify each disk after writing to it. This option will ensure that the
disk was copied properly, but will slow down replication by a factor of
two.

* Turn on the "Make Each Copy Unique" check box if you wish to have each
disk time-stamped with a slightly different time. If this option is
turned off, AmigaDOS will become confused (and possibly scramble the
data on the disks) if two identical disks are inserted into two
different drives at the same time. Turning this option on will slow down
replication by a second or two per disk.

* If you only wish to replicate a portion of a disk, select the "From ...
to ..." option and type the beginning and ending track numbers you wish
to replicate.

* Click the "OK" button to use the specified options.

Start-up Options

Replicator has the following start-up options:

"NoVerify" or "NV"
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Turn off the "Verify After Write" option.

"Clone" or "C"
Turn off the "Make Each Copy Unique" option.

1.15 Locator

Locator

Locator is a tool for finding files that you have either misplaced, or
forgotten where on your disks you put them. It searches for and displays a
list of files that match all or part of a name that you supply. For each
file found, Locator can show you information about the file - its location,
size, date it was created, file comments, and the first several hundred
bytes of the file’s contents. Using this information you can determine
which file it was you are looking for, and where to find it.

Locator is particularly useful for hard drive owners, since on a hard
drive with numerous files and drawers if you accidentally put a file in
the wrong drawer it could take you hours to find it. Locator can be set
to search for the file automatically, and you can have it search either
the entire drive or just a portion of it.

To start Locator and search for a file:

* Start Locator from the Workbench or CLI. Its window will appear:

* In the "Name:" text box, type all or part of the file name of the file
you want to search for.

* From the pop-up menu, choose the type of match you want for the name you
typed.

* In the "Search here:" text box, type the location (disk and drawer) in
which you wish to search. If you want to search an entire disk, you can
simply choose the disk name from the Project - Disks submenu.

* Click on "Locate" to begin searching. Locator will change its search
indicator to show that it is busy.

There are several different types of matches you can specify in the "Name:"
pop-up menu for matching the text that you type (if no text box is active,
you can also choose the match type by pressing the key equivalent):

contains key equivalent: C
Will list any file which has a name that contains the text. For example,
searching for files containing "text" in their name will match "Texture",
"Context", and "Contextually".

starts with key equivalent: T
Will list any file whose name starts with the text. For example, searching
for "Boat" will match "Boating", but not "Sailboat".

ends with key equivalent: E
Will list any file whose name ends with the text. For example, searching
for "Ship" will match "Space Ship", but not "Shipping".
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is key equivalent: I
Will list only those files whose names exactly match the text.

is not key equivalent: N
Will list only those files whose names do not exactly match the text. Since
this type of match can potentially list a large number of files, you should
restrict the search to a drawer on your disk to avoid sifting through a
very long listing.

doesn’t contain key equivalent: D
Will list any file whose name does not contain the text. Since this type of
match can potentially list a large number of files, you should restrict the
search to a drawer on your disk to avoid sifting through a very long listing.

matches pattern key equivalent: P
Will list any file whose name matches the AmigaDOS pattern you type in the
text box. This is a very powerful option, as it allows you to not only
duplicate all of the above types of matching, but also specify just about
any type of match criteria you can think of.

Using "matches pattern" under AmigaDOS 1.2 and 1.3, you can use the
following wild-cards:

"?" Matches any single character. For example, "a?c" will match "aac",
"abc", and so on.

"#" Matches any number of the following character. For example, "a#bc"
will match "ac", "abc", "abbc", and so on.

You can use both wild-cards together to broaden the search criteria. For
example, searching for "a#?c" will match any file whose name begins with
"a" and ends with "c".

Using "matches pattern" under AmigaDOS 2.0 or later, you can use any of the
additional AmigaDOS pattern specifiers described in your AmigaDOS manual.

After you click on the "Locate" button, Locator will begin searching the
disk and the search indicator will show that it is busy. As it finds files,
Locator will add their name to the file list. You can click on a file name
in the list at any time; you can also select files by using the up and
down cursor keys. When you select a file in the list, Locator will display
the location of the file in the "Path" list, information about the file in
the "Information" box, and the first several hundred bytes in the file in
the "Contents" box. You can examine this information to determine which
file it is you are looking for, and make a note of its location.

To display a file’s location and information:

* Select the file name in the file list by clicking on the name, or by
using the up and down cursor keys.

* The location of the selected file will be shown in the "Path" list.
Information about the file - its size, creation date, and comments - will
be shown in the "Information" box. The first several hundred bytes in
the file will be shown in the "Contents" box.

When Locator finishes searching, it will change its search indicator back
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to normal. You can also stop searching at any time.

To stop searching:

* Click on the "Stop" button.

* To quit from Locator, click in the close box, press the esc key, or
choose Quit from the Project menu.

Start-up Options

Locator has no start-up options. However, if you run Locator from the CLI,
you can supply a pattern and optionally a path to search. If you supply
these parameters, Locator will immediately start looking for matching
files. If you don’t supply a path, Locator will search the entire disk you
are currently on. For example, if from the CLI you type:

Locator Test#?

then Locator will immediately start looking on the disk you are currently
on for files whose names start with the word "Test". Similarly, if you type:

Locator #?Draw#? Work:Documents

then Locator will immediately start looking in the drawer "Documents" on
the disk "Work" for files whose names contain the word "Draw".

1.16 Encryptor

Encryptor

Encryptor is a program for protecting files from being examined or
modified by others. It "encrypts," (scrambles) files using a password you
supply. Once a file is encrypted, no one will be able to decode and
examine the file’s contents without the password.

Important:
Do not forget your passwords! Each file you encrypt can have its own
unique password, and you will not be able to decrypt the file if you
forget the file’s password. Since the password itself is scrambled along
with the file’s contents, there is no way of determining a file’s password
once it is encrypted. Furthermore, the passwords used by Encryptor are
case-sensitive. For example, a password of "Trains" is different than
"trains".

To use Encryptor:

* Start Encryptor from the Workbench or CLI. Its window will appear:

* Select the files you wish to encrypt from the list of file names shown.
You can select more than one name by dragging across the names with the
mouse, or by holding down the shift key when you click on a name.

File names are shown in normal type, drawer names are shown in italics and
are preceded by a dash "-".

The "Enter", "Back", and "Disks" buttons can be used to go to the drawer
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containing the files you wish to encrypt. Click on a drawer name and then
on the "Enter" button, or simply double-click on the drawer name, to list
the files in that drawer. Click the "Back" button to back out of the
current drawer and list the files in the "parent" drawer. Click on "Disks"
to display a list of disks to enter.

* Click on the "Encrypt" button to encrypt the selected files. You will be
asked for a password for each file you choose to encrypt. As a safety
measure, you will be asked to type the password a second time to verify
your first entry.

* Click on the "Decrypt" button to decrypt the selected files. You will be
asked for a password for each file you choose to decrypt. You must
supply the correct password in order to decrypt a file.

* To quit from Encryptor, click in the close box or press the esc key.

Start-up Options

Encryptor has no startup-up options.

1.17 Disk Eraser

Disk Eraser

Disk Eraser is a program that you can use to permanently erase information
on your disks. With Disk Eraser you can either erase only the unused space,
or the entire contents of a disk.

When to Use Disk Eraser

When you delete files either from the Workbench or the CLI, the data in the
file is not really erased; rather the information on where to find the
file’s data is simply removed from the Amiga’s directory list. Programs
such as Quarterback Tools use this fact to recover deleted files - they scan
the disk for the file’s data, collect it, and re-create a directory entry
for the file. Often this is a benefit, particularly when you delete a file
by accident. Sometimes, however, you may want a file to be completely
eliminated; such as when a file contains sensitive information that you do
not want others to have access to. Both the File Eraser and Disk Eraser
programs are designed to solve this problem.

Whereas the File Eraser program erases the contents of individual files, and
then deletes the files, Disk Eraser is designed to handle the situation
when you have already deleted one or more files and you later want to
permanently eliminate all traces of the file(s) prior existence.

Furthermore, Disk Eraser, by giving you the ability to erase an entire
disk’s contents, can also be used to permanently erase everything from a
disk. This is much like initializing a disk (using the Amiga’s "Format"
command), but is much more powerful - with Disk Eraser you can make several
"erase" passes over the disk, specify the binary value to use when erasing,
and even use an erasing method specified in the US Department of Defense
specification DoD 5220.22-M for permanently erasing magnetic memories.
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Disk Eraser erases the information on a disk in a slightly different manner
than File Eraser. A file erased with File Eraser will still be found by a
file recovery program such as Quarterback Tools - but when you recover the
file its contents will still be erased. On the other hand, Disk Eraser
access the disk directly, bypassing AmigaDOS. Therefore, when you erase a
disk with Disk Eraser, file recovery programs will not even be able to find
the erased files. Of course, this means that Disk Eraser will only work
with AmigaDOS disks that are created using a file system that it
understands, whereas File Eraser will be able to erase a file on any
AmigaDOS volume, regardless of the file system used to create the disk.

To use Disk Eraser:

* Start Disk Eraser from the Workbench or CLI. Its window will appear:

* Select the disk you wish to erase from the list of disks shown. Disk
Eraser will only display a disk name if it is able to erase the disk
(for example, network disks will not be shown, since Disk Eraser cannot
erase network disks).

* Select the type of erase you would like to perform. Select "Unused Space"
if you want to erase only the deleted files on the disk; select "Entire
Disk" if you want to erase everything on the disk.

* Click on the "Erase" button to erase the disk. You will be asked to
confirm the selected erase option. While the disk is being erased, a
progress indicator will be displayed. You can stop the erase process at
any time (but, of course, information that has already been erased will
not be recoverable).

* To quit from Disk Eraser, click in the close box or press the esc key.

When you select the "Entire Disk" option for erasing a disk, the disk will
need to be initialized after being erased in order to be available for
use. If you are using AmigaDOS 1.3 or earlier, you will need to perform
this initialization yourself, either using the Workbench’s "Initialize"
command, or the CLI’s "Format" command. If you are using AmigaDOS 2.0 or
later, Disk Eraser can perform the initialization automatically.

As mentioned above, there are several different options you can specify
for erasing disks. You can specify the number of passes to use when
erasing, the binary value to use for erasing, and even use the US
Department of Defense method of erasing disks.

To set erase options:

* Click on the "Options" button in the Disk Eraser window. A requester
will appear:

* Select "Standard Erase" to use the standard erase method.

* Select "US Government Erase" to use the US Department of Defense erase
method.

* Click on the "Value:" up and down arrow buttons, or press the up and
down cursor keys, to set the value to use for erasing. The value is
displayed in hexadecimal.

* Click on the "Repeat:" up and down arrow buttons, or press the shift-up
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and shift-down cursor keys, to set the number of passes to use for
erasing.

* Click the "OK" button to use the new options.

When using the standard erase method, Disk Eraser will write the
specified value into every location on the disk to be erased, and will
repeat it as many times as you have specified.

When using the US Government erase method, Disk Eraser will write a pass
of all zeroes (hexadecimal $00) and then a pass of all ones (hexadecimal
$FF) to every location on the disk to be erased, and will repeat this as
many times as you specify. At the end of these passes, it will write one
pass using the value you specified. For example, if you specify a US
Government erase using two passes and a value of $66, then Disk Eraser
will perform a total of five erase passes over the disk - a pass of all
zeroes, a pass of all ones, another pass of all zeroes, another pass of
all ones, and a final pass of $66.

Start-up Options

Disk Eraser has the following start-up options:

"Value:number" or "Value=number" or "V:number" or "V=number"
Set the value to use for erasing. The number given must be a decimal
number in the range 0 to 255, or a hexadecimal number in the range $00
to $FF. If you are specifying the value in hexadecimal, you must precede
the number by a "$" sign.

"Repeat:number" or "Repeat=number" or "R:number" or "R=number"
Set the repeat count for erasing. The number given must be a decimal
number greater than zero.

"Government" or "G"
Use the US Department of Defense erase method. By default, Disk Eraser
will use the Standard erase method unless you specify this option.

For example, to start Disk Eraser from the CLI, specifying an erase value
of 15 and a government erase with two passes, you would type the following
command line:

"Disk Eraser" -V:15 -R:2 -G

1.18 File Eraser

File Eraser

File Eraser is a program that you can use to permanently erase files from
your disks. Unlike the CLI’s "Delete" command (or the Workbench’s
Trashcan), the contents of files that you erase with File Eraser cannot be
recovered by any disk or file recovery program, not even Quarterback Tools.

When to Use File Eraser

When you delete files either from the Workbench or the CLI, the data in the
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file is not really erased; rather the information on where to find the
file’s data is simply removed from the Amiga’s directory list. Programs
such as Quarterback Tools use this fact to recover deleted files - they
scan the disk for the file’s data, collect it, and re-create a directory
entry for the file. Often this is a benefit, particularly when you delete
a file by accident. Sometimes, however, you may want a file to be completely
eliminated; such as when a file contains sensitive information that you do
not want others to have access to. Both the File Eraser and Disk Eraser
programs are designed to solve this problem.

File Eraser erases the contents of individual files, and then deletes the
files. While this method does not prevent file recovery programs like
Quarterback Tools from recovering the file, the contents of the recovered
file will still be erased. Using this method of erasing files has the
advantage that it can be used to erase any file - even files that are on
shared network disks.

Furthermore, with File Eraser you can make several "erase" passes over the
disk, specify the binary value to use when erasing, and even use an erasing
method specified in the US Department of Defense specification
DoD 5220.22-M for permanently erasing magnetic memories.

To use File Eraser:

* Start File Eraser from the Workbench or CLI. Its window will appear:

* Select the files or drawers you wish to erase from the list of file and
drawer names shown. You can select more than one name by dragging across
the names with the mouse, or by holding down the shift key when you
click on a name.

File names are shown in normal type, drawer names are shown in italics and
are preceded by a dash "-". Note that when you erase drawers, every file
in the drawer (and optionally, every file in sub-drawers of that drawer)
will be erased.

The "Enter", "Back", and "Disks" buttons can be used to go to the drawer
containing the files you wish to erase. Click on a drawer name and then on
the "Enter" button, or simply double-click on the drawer name, to list the
files in that drawer. Click the "Back" button to back out of the current
drawer and list the files in the "parent" drawer. Click on "Disks" to
display a list of disks to enter.

* Click on the "Erase" button to erase the selected files and/or drawers.

* To quit from Disk Eraser, click in the close box or press the esc key.

As mentioned above, there are several different options you can specify
for erasing. You can specify the number of passes to use when erasing,
the binary value to use for erasing, and even use the US Department of
Defense method of erasing disks.

To set erase options:

* Click on the "Options" button in the File Eraser window. A requester will
appear:

* Select "Standard Erase" to use the standard erase method.
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* Select "US Government Erase" to use the US Department of Defense erase
method.

* Click on the "Value:" up and down arrow buttons, or press the up and down
cursor keys, to set the value to use for erasing. The value is displayed
in hexadecimal.

* Click on the "Repeat:" up and down arrow buttons, or press the shift-up
and shift-down cursor keys, to set the number of passes to use for erasing.

* Turn on the "Verify Before Erasing" option if you wish to be asked to
proceed before erasing a file. The default is to have this option on.

* Turn on the "Erase Sub-drawers" option if you wish to have the contents
of sub-drawers erased when you erase a drawer. If you leave this option
turned off, only the files in the drawer itself will be erased - files in
sub-drawers will not be affected. The default is to have this option off.

* Turn on the "Automatically Erase Icons" option if you wish to have icon
files (".info" files) automatically erased when you erase a file. If this
option is turned on, then icon files will not be listed in the file name
list. The default is to have this option on.

* Click the "OK" button to use the new options.

When using the standard erase method, File Eraser will write the specified
value into every location on the disk to be erased, and will repeat it as
many times as you have specified.

When using the US Government erase method, File Eraser will write a pass of
all zeroes (hexadecimal $00) and then a pass of all ones (hexadecimal $FF)
to every location on the disk to be erased, and will repeat this as many
times as you specify. At the end of these passes, it will write one pass
using the value you specified. For example, if you specify a US Government
erase using two passes and a value of $66, then File Eraser will perform a
total of five erase passes over the disk - a pass of all zeroes, a pass of
all ones, another pass of all zeroes, another pass of all ones, and a final
pass of $66.

Start-up Options

File Eraser has the following start-up options:

"Value:number" or "Value=number" or "V:number" or "V=number"
Set the value to use for erasing. The number given must be a decimal number
in the range 0 to 255, or a hexadecimal number in the range $00 to $FF. If
you are specifying the value in hexadecimal, you must precede the number
by a "$" sign.

"Repeat:number" or "Repeat=number" or "R:number" or "R=number"
Set the repeat count for erasing. The number given must be a decimal number
greater than zero.

"Government" or "G"
Use the US Department of Defense erase method. By default, Disk Eraser will
use the Standard erase method unless you specify this option.
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"Subdrawers" or "S"
Erase the contents of subdrawers when erasing a drawer.

"NoIcons" or "NI"
Do not automatically erase icons when erasing files.

"NoWarn" or "NW"
To not warn before erasing files.

For example, to start File Eraser from the CLI, specifying an erase value
of 15 and a government erase with two passes, you would type the following
command line:

"File Eraser" -V:15 -R:2 -G

1.19 System Mover

System Mover

System Mover is a program which simplifies the task of installing and
removing fonts and other system files. You can use System Mover to add or
remove fonts that you use regularly, remove printer drivers or "keymaps"
that you do not use, or install and update system libraries and CLI
commands. Since System Mover can also show you the version numbers of
system files on your disk, you can use it to make sure you are using the
latest version of the system software.

About System Files

If you use only the Workbench to run programs and delete files, and have
never used the CLI, then you may not be aware that there are a large number
of files on a Workbench disk that are hidden from Workbench’s view. These
"system" files are used for many operations, including providing common
code routines for application programs, handling devices attached to your
computer (such as a modem or printer), and dealing with the CLI
environment. Fonts are contained in another type of system file that is
also inaccessible to Workbench users. Unfortunately, for Workbench users
this means that you have to use the CLI in order to do simple operations
like updating your system to a new version, or simply installing fonts onto
your Workbench disk. This is where the System Mover comes in.

System Mover allows you to easily move system files of all types from one
disk to another. When moving font files, it automatically updates all the
appropriate font description (".font") files, thus ensuring that these fonts
will be accessible to all programs. Even for users familiar with the CLI,
System Mover comes in handy since it will display information about the
version of certain system files or, when version information is not
available, information about the size of the file and when it was created
(this information is useful in determining if you have the latest version
of the system file).

There are eight different kinds of system files that System Mover handles:

Fonts Data for bit-map fonts. (Note: System Mover cannot move
outline fonts. To move outline fonts, use the outline font
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utility supplied with AmigaDOS.)

Printers Printer drivers for various printers. See Amiga User’s
Manual for a list of current drivers and compatible printers.

Keymaps Information to translate the key presses on your keyboard
into the actual characters that a program uses.

Libraries Common routines that all programs can access.

Devices Routines that handle various devices (or pseudo-devices)
that may be connected to your computer.

Handlers Similar to devices, but interact with AmigaDOS rather than
the Amiga’s Exec system.

CLI Commands Routines that execute the commands typed in a CLI window.

CLI Scripts Files containing several CLI commands that are to be
executed in succession.

Using System Mover

Using System Mover is very simple. You don’t have to know anything about
the contents of the files you are copying, you just select one or more
files to copy, specify which disk to copy them from and to, and tell System
Mover to copy them.

To use System Mover:

* Start System Mover from Workbench or the CLI. Its window will appear:

* From the Move menu, choose the type of file you want to copy or remove.
The choices are Fonts, Printers, Keymaps, Libraries, Devices, Handlers,
CLI Commands, and CLI Scripts.

* Choose the disk you want to copy the files from by choosing the disk name
from the From Disk sub-menu in the Disk menu. The disk must be currently
inserted into a disk drive for it to be listed in the sub-menu; if the
disk you want to move the files from is not listed, then insert the disk
into a disk drive, wait a second or two for System Mover to update the
sub-menu, and then choose the disk from the sub-menu.

Once you have chosen a disk to copy files from, System Mover will get a
list of the files of the appropriate type from that disk. You can now
choose to either remove files, or copy them to another disk.

* If you want to copy files from one disk to another, choose the disk you
want to copy the files to from the To Disk sub-menu in the Disk menu.
Again, the disk must be currently inserted into a disk drive for it to be
listed in the sub-menu. If you only want to remove files you can skip
this step.

* Now select any file you want to copy or remove by clicking once on the
file name in the list. If the file is not listed you can scroll the list
up or down by clicking on the scroll arrows or by dragging the scroll box
next to the list of files. You can select more than one file at a time by
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holding down the shift key when you click on a file name, or by dragging
across a range of files. To undo a selection, simply hold down the shift
key and click on the file name again.

When you select a file, information about that file is displayed in the
bottom portion of the window. For fonts, an example of the font is
displayed. For other types of files, information about the version of the
file is displayed if it is available. If version information is not present
in the file, the file size and creation date are displayed.

* Once you have selected the file or files you want to copy, click on the
"Copy" button. The files will be copied from the "From" disk to the
"To" disk. When fonts are copied, the font description (".font") file
will be automatically updated. Also, if there is a metric file for that
font, it will also be copied (metric files are used by ProWrite and other
programs to obtain additional information about the fonts present in your
PostScript printer).

* If instead you wish to remove the selected files, click on the "Remove"
button in the window. The files will be removed from the "From" disk. Be
careful with this option, there is no way to get back what you remove!

* You can continue to copy files to and from different disks, of either
the same or different file types, simply by choosing new selections for
"From" and "To" disks from the appropriate sub-menus and new types of
files from the Move menu.

* When you are done, either click in the close box of the window, press
the esc key, or choose Quit from the Disk menu to quit from System Mover.

Start-up Options

System Mover has no startup-up options.

1.20 Key Finder

Keystroke Finder

Keystroke Finder is a program to help you find the keystroke combination
for any Amiga character. This is useful when you need to know how to type
accented characters, or special symbols.

Note:
Unlike other programs in Quarterback Tools Deluxe, Keystroke Finder
requires AmigaDOS 2.0 or later. If you do not have AmigaDOS 2.0 or later,
you will need to upgrade your system. See your local Amiga computer dealer
for more information.

To use Keystroke Finder:

* Start Keystroke Finder from the Workbench or CLI. Its window will appear:

* Click on the character whose keystroke you wish to find. The keystroke
combination, as well as the decimal and hexadecimal ASCII code numbers
will be shown.
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* To quit from Keystroke Finder, click in the close box or press the esc key.

Keystroke Finder shows keyboard keys as capital letters, which is the way
they are printed on the tops of the keys. Therefore, if Keystroke Finder
tells you to press the "H" key, it means to press the key without holding
down the shift key. If you do need to hold down the shift key, Keystroke
Finder will show that as part of the keystroke information. For example, if
you click on "H" in the display, the keystroke is given as "shift-H".

Some characters, particularly those which have accents, require more than
one keystroke. When more than one keystroke is required, the individual
keystrokes will be separated by a comma. For example, with the USA keymap,
the keystroke for É is listed as "alt-F, shift-E", which means that you must
type alt-F, then type shift-E.

Keystroke Finder can display the character array in either a horizontal or
vertical orientation.

To switch the window display:

* Click in the arrow button in the lower right corner of the window, or
press return. The window will switch from the horizontal to the vertical
orientation, or vice-versa.

Start-up Options

Keystroke Finder has a single start-up option:

"Horizontal" or "H"
Start up in the horizontal window display. If you do not specify this
option, Keystroke Finder will start up using the vertical window display.

1.21 BrainCloud

Brain Cloud

Brain Cloud modifies a floppy disk so that it cannot be accessed by the
Amiga system. Even the "Format" command will not work on a disk that has a
"brain cloud." This is a convenient way of protecting disks from accidental
modification by others. No one can alter files, delete files, or format the
disk until the brain cloud is removed.

To use Brain Cloud:

* Start Brain Cloud from the Workbench or CLI. Its window will appear:

* From the pop-up list, choose the drive containing the floppy disk you
wish to modify. Only drives you have attached to your system will be
displayed in the list.

* Click on either the "Cloud" button to brain cloud a disk, or the
"Un-Cloud" button to remove a brain cloud.

* To quit from Brain Cloud, click in the close box or press the esc key.

Brain Cloud is designed to protect disks from normal operations; it is not
intended to thwart advanced users from being able to access floppy disks.
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Advanced file recovery programs such as Quarterback Tools can also detect
and fix brain clouded disks.

Startup-up Options

Brain Cloud has no startup-up options. However, you can run Brain Cloud
entirely from the CLI by typing the command line:

"Brain Cloud" <drive name> [ON|OFF]

When you specify both a drive name and an ON or OFF parameter, Brain Cloud
will not display its window, but will just perform the operation and quit.
For example, typing:

"Brain Cloud" DF0: on

will put a brain cloud on the disk in drive DF0: without displaying the
main window.

1.22 Shortcuts

Shortcuts

The programs in Quarterback Tools Deluxe share a number of similar
shortcuts to streamline their operation. Here is a list of those shortcuts:

* You can select most push buttons, check boxes, and option buttons in the
windows and requesters by simply pressing the key corresponding to the
underlined character in the button name.

* When there is an outlined push button in a window or requester, you can
select that button by pressing the enter key. You can also select it by
pressing the return key, unless you are in a linked text box (see below).

* In most requesters, the "Cancel" or "No" push button can be selected by
pressing the esc key. Also, in most windows, the close box can be
selected by pressing the esc key.

* In windows and requesters that have text boxes, you can activate the
first text box by pressing the tab key. If you are using AmigaDOS 2.0 or
later you can switch from one text box to another by pressing tab (to go
to the next text box) or shift-tab (to go to the previous one).

* When two or more text boxes control related items, the text boxes are
"linked." You can switch among linked text boxes, regardless of the
version of AmigaDOS you are using, by pressing return and shift-return.

* Pressing the help key will display the "About" requester.

* If you are using AmigaDOS 2.0 or later, the program windows will have a
"zoom" box on the right side of the window’s title bar. In all programs
except Quarterback Tools, clicking this box will shrink the window to
just a title bar. Clicking in it again will bring the window back to
full size. In Quarterback Tools, clicking in this box will shrink or
grow the window to smaller or larger sizes, depending upon the tool
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selected.

In addition, the file requesters used by several programs in Quarterback
Tools Deluxe have a few more key equivalents:

Key: Action:

Cursor up Move selection up
Cursor down Move selection down
Cursor right Enter selected directory
Cursor left Back out one directory level
alt-cursor left Display disk list

1.23 Appendix: Troubleshooting

Appendix: Troubleshooting

This appendix lists some suggestions for dealing with the most common
problems you might encounter when using the Quarterback Tools Deluxe
programs. If you aren’t able to find the answer to your problem here or
elsewhere in the manual, please call or write to us for assistance. Our
technical support address is:

Quasar Distribution
Attention: Customer Support
PO Box 101
Vermont
Victoria 3133
Australia

Phone: +613 9887 2411.
Fax: +613 9887 2511

You can also contact us on email:
qback@quasar.dialix.oz.au

Not enough memory.

Some operations in the Quarterback Tools Deluxe programs may require
considerable amounts of memory. If you experience memory problems, try
quitting from other programs and removing memory-resident utilities you
have running. Also try running the program after freshly restarting your
system.

Quarterback Tools reports that there is still one fragmented file after
optimizing the drive.

This is due to the way AmigaDOS writes files, and is normal behavior. See
the note about optimizing on page 27 for more information.
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1.24 Glossary

Glossary

Bad blocks Disk blocks which are known to have physical (read/write)
errors, and which must not be used.

Bitmap A volume file control structure containing one bit for each
block on the volume, indicating whether or not the block is
allocated or available for use.

Block The basic unit of data storage on a disk. A block consists
of 512 bytes of data which are read and written together.
Also called a sector.

Block number A unique identification number assigned to each block of a
volume. Also called a key.

Checksum A value that is included in a block and is used to
determine whether the data in a block is correct.

Cylinder Two or more tracks, each on a different surface of a disk.

Defragmenting The process of collecting into one place on the disk the
scattered pieces of a fragmented file.

Device driver Software which controls a disk drive or other device. A
device driver performs the actual reading and writing to a
device in response to requests from AmigaDOS or other
programs.

Directory Cache File System
A file storage system similar to the Fast File System and
Old File System, but which uses additional disk space to
compactly store ("cache") a subset of directory information
in order to produce faster directory listings.

Fast File System
An improved file storage system introduced with AmigaDOS
2.0 (and available as an option with AmigaDOS 1.3).

File header A control block containing information about a specific
file, such as the name, size, creation date, and location
of all data blocks for the file.

Format The process of preparing a volume to store files by writing
an "empty" file structure to it. Also called Initialize.

Fragmented file A file which is split into two or more pieces (fragments)
which are stored in different areas of the volume.

Initialize The process of preparing a volume to store files by writing
an "empty" file structure to it. Also called Format.

International File System
A file storage system that is similar to the Fast File
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System and Old File System, but which handles file names
containing international characters slightly differently.

Invalid volume A volume which has failed the basic integrity test applied
by AmigaDOS. If the volume fails these tests, AmigaDOS may
refuse to read or write files on the volume.

Key A unique identification number assigned to each block of a
volume. The key corresponds to a physical track and sector
address on the disk. Also called a block number.

Logical error A disk error caused by corrupted data in a block. Logical
errors can be corrected by software.

Mount The process of making a volume available. Floppy disks are
mounted when they are first inserted into a disk drive.
Hard disks are usually mounted when the system is started.

Old File System The original AmigaDOS file storage system.

Optimization The process of defragmenting files and repositioning files
and drawers to optimum locations on a disk in order to
maximize disk performance.

Partition An area of a hard disk having a unique volume name and
containing its own logical file structure. A hard disk can
be divided into many partitions.

Physical error A disk error caused by physical damage to the disk surface,
failure of the drive mechanism, or failure of the disk
controller hardware. Physical errors cannot be corrected by
software.

Reserved blocks Two or more blocks at the beginning of a volume which are
excluded from the accessible space of the volume.

Root block A special drawer stored in a predefined location on a disk.
The root block contains the name of the volume and is the
root of a "tree" of information about all other drawers and
files on the volume.

Sector The basic unit of data storage on a disk. A sector consists
of 512 bytes of data which are read and written together.
Also called a block.

Track A group of blocks which form a complete circle on a single
side of a disk.

Valid volume A volume which has passed the basic integrity checks
applied by AmigaDOS when the volume is first mounted.

Validation The process of verifying the integrity of a volume by
performing several tests on the root block and bitmap. These
tests are made when the volume is first mounted.

Volume A particular floppy disk or hard disk partition. A volume
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shows up as a unique disk to Workbench.
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